
 

 

Pyramix V12 Release Note 

アップデート前の重要なお知らせ： 
● Pyramix V12は、第４世代以降の Intel Ci シリーズ CPUにのみ対応しています。それ以外のCPU

をご使用の場合は販売代理店にご相談頂き、新しいPCへの移行をお願いいたします。 

● Pyramix V12には、Pyramix V12用のソフトウェア ライセンス キー ファイルが必要です。お持

ちでない場合は販売代理店にアップグレードをお申し込みください。 

● Pyramix V12は、Windows 10 Pro 64bitとWindows 7 Pro 64bitにのみ対応しています。Windows 
10 Pro 64bitのアップデートへの対応状況は、この文章情報中に書かれています。使用している

OSが、対応バージョンであることをご確認ください。 

● 以前のバージョンのPyramixが動作しているPCをPyramix V12にアップデートされる場合、既に

完了したプロジェクトの保護、テンプレートやショートカットのバックアップなどを行ってく

ださい。 
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新機能と機能強化のハイライト 
完全なハイブリッドチャンネルベース＆Ambisonicワークフロー 

Pyramix 12には完全なハイブリッド チャンネルベース/アンビソニック ワークフローが含まれており、ア

ンビソニック信号を直接Pyramixのミキシング コンソールでエンコード、ミキシング、回転、デコードす

ることができます。Ambisonic Decoder は、Pyramixミキサー内の ​b <> com​インテグレーションにより、

Pyramix v12およびOvation v8で最大7次までサポートします。 

● VR Packキー​が存在する場合、3〜7次のAmbisonic StripsおよびAmbisonic Groupは正しくデコー

ドされます。 

● VR Packキー​が存在しなくても、1次と2次のAmbisonic StripsとAmbisonic Groupは常にデコード

されます。 

● VR Packキー​が存在しない場合、3〜7次のAmbisonic StripsおよびAmbisonic Groupは2次デコーダ

を使用してデコードされます。 
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ミキサーの改良 

● バス マトリックス グリッド：ミキシングコンソールのGeneral Mixing Busセクションは、大き

なマトリックス グリッドとして操作することができます。 

● 新しいスクロール：ミキシング コンソールにマウス ホイールのサポートが追加されました。 

● 移動可能なエレメント：VCAストリップとグループ ストリップはミキサーで移動することがで

きる様になりました。 

● ルーティング プリセット：Pyramix v12では、ミキシング コンソール ルーティング ページ内で

新しくSave / Load プリセットが用意されています。 

● 新しい定義済みのスピーカーセット 

 
EVO CHANNEL＆EVO IN - VS3プラグイン フォーマットで利用可能（キーが

必要） 

EVO CHANNEL：究極のチャンネルストリップ 
EVOは、ゲイン/ドライブ、フェーズ、コンプレッサー、EQ、ディエッサー、エキスパンダー、トラン

ジェント/サステインデザイナー、ハンズオンインターフェイス、高速ワークフロー、調整可能なシグナル

フロー、サウンドのコントロールの機能が備わった新しいチャンネルストリップです。 
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EVO IN：位相を合わせ、音のバイタリティーを維持させます 

独自の、正確な、任意の、そして直線的な位相回転を行います。フェイズ グループに含まれているすべて

のトラックの位相を同時に有効または無効にします。ソフト サチュレーション機能により、音の 丸みと

暖かさを持たせることができ、音のバイタリティを維持させます。 
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オーサリングとアルバム パブリッシングの機能強化 

全般 

● Generate Master：Generate CD / SACD image を改良し、追加機能を加えました。 

● MTFF デジタル リリースのインポート：修正が必要な場合、MTFFデジタル リリースをPyramix
タイムラインにインポートしてCDタグを編集できるようになりました。 

● 新しくCDテキストインポート機能（CDTEXT.BIN）が加わりました。 

DXD / DSDの新機能 

● SACD CMウィザードに代わる新しいSACD Cutting Master生成機能 

● Digital Release では、DSDレンダリングモードまたはミックスダウンモードでDSD128および

DSD256 Editマスターを生成できます。これにより、アルバムパブリッシング用のDSD128およ

びDSD256入力フォーマットも可能になります。 

● アルバム パブリッシングで、新しくMecoシグマデルタ変調器が使用できるようになりまし

た。 

● DSDレンダーは現在、オリジナルのDSDマテリアルサンプルレートでDSD処理を提供します（

DSD64では64 F、DSD 128では128 F、DSD 256では256 F）。 

● MTFF DSD Digital Release Generationは、アルバム パブリッシングまたはDiscWriteにインポー

トできます。 
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DiscWrite MTFF 編集サポート 

● DiscWriteではテキストバリデーターが利用可能になり、顧客または工場にファイナル マスター

を納品前に最終検証が実行されるようになりました。 

Windows 10 October 2018アップデート（1809）サポート 

Zombieloadの更新が含まれます（2019年5月14日にリリースされたマイクロアーキテクチャーデータサン

プリング）。 

警告​：Windows 2019年5月アップデート1903 / 19H1は、現状MassCoreでサポートされていません。 

Merging はNativeとMassCoreが常に最新バージョンのオペレーティングシステムをサポートする様に努力

しています。Mergingのナレッジベースの​Windowsの10 Updateページ​を御覧ください。 
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ANEMAN V1.2 

新しいANEMAN 1.2は、Horus、Hapiそして/またはAnubisエコシステムをPyramix v12 / Ovation v8で使用

するために必須となりました。このバージョンでは、マルチキャスト（紫）とユニキャスト（青）の接続

がありますので、新バージョンをインストールした後は古いバージョンで行った接続を確認する必要があ

ります。ユニキャスト/マルチキャストの詳細については、ナレッジベースの​このページ​を参照してくださ

い。 

● MERGING + ANUBISとZOEMのサポート： MERGING + ANUBISまたはZOEMのネットワーク接続

を管理するには、ANEMAN 1.2を使用してください。 

● ユニキャストのサポート： ANEMANのマルチキャストサポートを補完するために、1つの送信

元を1つの送信先に接続するためのユニキャストサポート、つまり1対1を追加しました。 

● 検出とゾーンの改善：デバイスの検出とゾーン管理の処理が改善されました 

● 新しいプラグインのサポート： Rossデバイスのプラグインのサポート 
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Pyramix v12 インストールガイド 

Pyramix v12は、以下の基本ソフトウェアおよびハードウェアと互換性があります。ご使用されているPC
の仕様が合っていることをお確かめの上、インストールを行ってください。 

OS 

● Windows 7 Professional (64bit) 

● Windows 10 Professional (64bit) Anniversary (1607) 

● Windows 10 Professional (64bit) Creatir (1703) 

● Windows 10 Professional (64bit) Fall Creator (1709) 

● Windows 10 Professional (64bit) Soring Creator (1803) 

● Windows 10 Professional (64bit) October update (1809) 

● Windows 10 Zombieload update 

 

ハードウェア（プロセッサー） 

● 第４世代以降の Intel Ci5/7 プロセッサー （第３世代以前のプロセッサーはサポートされていま

せん） 

 

インストールについて 

1. Pyramix v12には、Pyramix V12用キーファイルが必要です。アップデート インストールを行う

前に、キーファイルがあることをお確かめください。 

2. Pyramix v12以前のPyramixをインストールされていたユーザーは、コントロールパネル > プロ

グラムと機能 で以前のバージョンのMerging社製品ソフトウェアを削除（アンインストール）

してください。 

※　削除（アンインストール）対象のソフトウェア 
● Pyramix Virtual Studio x64 
● Ovation x64 
● VCube x64 
● Merging Ravenna  ASIO Driver x64 
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3. 削除（アンインストール）後に再起動を促された場合は、再起動を行ってください。また他の

ソフトウェアでも、削除を行った場合は、Pyramixをインストール前に必ずPCの再起動を行っ

てください。 

4. インストールにはインターネットの接続が必要です。PCがインターネットに接続されているこ

とをお確かめの上、インストール作業を行ってください。 

5. Pyramix V12 のインストーラー（PyramixVirtualStudio_12.0.4__Build683_x64.exe）をダウン

ロードし、起動させてください。 

6. インストール後に、PCの再起動を求められたら再起動してください。 

7. Merging Ravenna ASIO Driver を使用されている場合は、Merging Ravenna ASIO Driverもインス

トールしてください。インストール後にPCの再起動を促されますので、PCを再起動してくださ

い。 

8. FLUXのプラグインを使用されている場合は、​Flux_FluxCenter-64-bit_Windows_Installer.exe​ を
使用して​プラグインをインストール​してください。 

9. USBシリアルキーをPCに接続してください。USBシリアルキーのLEDが緑色に点灯することを

確認してください。※シリアルキーはPyramixがインストールされていないと点灯しません。 

10. Pyramix V12用キーファイルをダブルクリックし、ライセンスを認証させてください。キーファ

イルをダブルクリックしてMT Security が開かない場合は、コントロール パネル > MT Security 
Settings を開き、Importをクリックしてキーファイルのあるディレクトリーをブラウズし、指

定してライセンス認証を行ってください。 

11. Pyramix v11でMassCore を使用されていたユーザーは、コントロール パネル > MT Security 
Settings を開き、MassCoreのタブを開いてください。ここで​UnInstall​ をクリックし、以前の

バージョンのMassCoreをアンインストールしてください。この作業を行うと再起動を促されま

すのでPCを再起動してください。 

12. Pyramix V12でMassCore を使用されるユーザーは、再度コントロール パネル > MT Security 
Settings を開き、MassCoreのタブを開いてください。ここで ​Install ​をクリックし、Pyramix 
V12用のMassCoreをインストールしてください。この作業を行うと再起動を促されますのでPC
を再起動してください。 

13. コントロール パネル > VS3 Control Panel を開き、Pyramixで使用する入出力用のドライバーを

設定してください。 
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MassCoreユーザーの設定例： 

 

Nativeユーザーの設定例： 

Ravenna ASIO を使用している場合は、Driver name の欄でRavenna ASIO Driver を選択してください。 
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Pyramix v12 リリースノート 
新機能： 

Ambisonicサポート： 

Pyramix 12には完全なハイブリッドチャンネルベース/アンビソニックワークフローが含まれており、アン

ビソニック信号を直接ミキシングコンソールでエンコード、ミキシング、回転、デコードすることができ

ます。 

● 7次までのAmbisonicは完全にサポートされています。詳細はVR Packのキー情報を参照してく

ださい。 内部Ambisonicチャンネル番号付けとノーマライズはAmbiX / SN3Dです。 注：Aから

BへのフォーマットとFumaからAmbiXへの変換にはプラグインを使用してください。 

●  Strips > Add > Multi Channel Strip のミキサーのコンテキストメニューのチャンネルマッピング

リストに7つのアンビソニックオーダーが追加されました。 

● Bus > Add > General Mixing Bus のミキサーのコンテキストメニューのチャンネルマッピングリ

ストに7つのアンビソニックオーダーが追加されました。 

● チャンネルベースのストリップがアンビソニックバスと交差する場合、チャンネルベースの信

号はアンビソニックにエンコードされ、従来のパンナーを使用してパンされます。 この場合、

サラウンドパンナーウィンドウには、方位角と高度の2つのスライダーも表示されます。 特定

のストリップとバスのバスコントロールコンポーネントにA-Panが表示され、Ambisonic 
Panningが示されます。 この場合、チャネルルーティングは利用できません。 

● ステレオまたはマルチチャンネルストリップがAmbisonicバスを通過する場合、チャンネル

ベースの信号はチャンネルごとにAmbisonicにエンコードされ、同じオプション（バランス、

デュアルパン、ソースサイズ付きシングルパンなど）を使用して従来のパンナーを使用してパ

ンされます。 この場合、サラウンドパンナーウィンドウには、方位角と高度の2つのスライ

ダーも表示されます。 特定のストリップとバスのバスコントロールコンポーネントにA-Panが
表示され、Ambisonic Panningが示されます。 この場合、チャネルルーティングは利用できま

せん。 

● Ambisonic StripがAmbisonic Busと交差する場合、バスコントロールにはA-MixとA-Rotの2つの

オプションがあります。 

● A-MixはChannel Routingウィンドウに対角線を表示するだけです。 これは高度な使い方です。 
すべての値を0.0に保つことをお勧めします。 

● A-Rotは、パンナーバスとサラウンドパンナーウィンドウの両方に回転ツールを表示します。 こ
れにより、Ambisonic Bus（出力シーン）内のAmbisonic Strip（入力シーン）を回転させるこ

とができます。 

● アンビソニックストリップがチャンネルベースのバスと交差する場合は、アンビソニックデ

コーダが適用され、アンビソニック信号がバスのスピーカーセット（またはチャンネルマッピ

ング）にデコードされます。 
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● ミキシングに関して、デコード前に回転を適用する（Ａ − Ｒ ＋ Ｄ）か、またはデコードのみ

（Ａ − Ｄｅｃ）を行うかの選択ができます。 

● Ambisonic Stripsは、このストリップのPannerバスにAmbisonicのロゴを表示し、Zの回転を制

御します（下記参照）。 

● 選択したストリップでAmbisonicバスが有効になっている場合、Surround Panningウィンドウ（

View > Windows /Tools >  Surround Panner またはPannerバス上でCTRL +クリック）に

Ambisonicロゴが表示されるようになりました。 

● 特定のストリップでチャンネルベースのバスとAmbisonicバスの両方が有効になっている場合

は、Ambisonicのロゴとスピーカーを表示する従来のRoom Cubeの両方が表示されます。 

● Ambisonicバスが表示されている（Ambisonicロゴが表示されている）ときのサラウンドパン

ナーウィンドウでは、白い四角のパンポイントに明るい青い円が表示されます。 これはX / Y / 
Z点に相当する方位角/標高で、半径は1.0です。パンポイントと球体の表面を横切る球体の中心

との間の直線の交点です。 これがAmbisonic Panned pointです。 

● サラウンドパンウィンドウには、従来の上面ビューと背面ビュー、新しい上面ビューと円筒

ビュー（Cylindrical View）、および新しい円筒ビュー（Cylindrical View）のみを切り替えるこ

とができる新しい Display Mode ボタンがあります。 

● 円柱ビュー（Cylindrical View）を操作するとき、方位角と標高は動きの影響を受け、半径は自

動的に1.0に維持され、従来のパンポイントとアンビソニックパンポイントの両方がシーン球体

表面に配置されるようになります。 

● 円柱ビュー（Cylindrical View）の操作中にCTRLキーを押すと、従来のパンポイントは（球では

なく）X / Y / Z立方体の端に固定されるため、常にスピーカー間を直線で移動します。 これに

より、チャンネルベースの信号をパンするときに円柱ビューを最適な方法で使用できます。 

● ミックスダウンで利用可能なADMエクスポートは、Ambisonic関連情報を正しくエクスポート

します。 

Ambisonic Decoders: 

● Ambisonic DecoderはPyramix v12で7thまでサポートされ、b <> com DecoderはPyramixミキ

サーに統合されました.。 

その他の変更： 

● 新しいバスまたは新しいマルチチャンネルストリップを作成するときに使用できる標準スピー

カーセットリスト（チャンネルマッピングリスト）は、最新の業界標準に合わせて再編成され

ました。ITU-R BS.2051-1レコメンデーションにあるスピーカー配置形式は、ほとんどこのリス

トに含まれています。 

● 新しいマルチチャンネルトラック＆ストリップを作成するときに、タイムラインのAdd Audio 
Track メニューに Standard Speaker Sets リストが表示されるようになりました。 
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VR Pack オプション： 
● VR Packキーを持っていないシステムでも、1次と2次のAmbisonic StripsとAmbisonic Groupは

常にデコードされます。 

● VR Packキーを持っているシステムでは、3〜7次のAmbisonic StripsおよびAmbisonic Groupが
正しくデコードされます。 

● VR Packキー持っていないシステムでは、3〜7次のAmbisonic StripsおよびAmbisonic Groupは2
次デコーダを使用してデコードされます。 

Note： 

● アンビソニックストリップとバスは、ミキサーのコンテキストメニューまたは Configure ペー

ジで作成できます。 

● Ambisonic Busのチャンネルタイプは変更できません。 

● Ambisonicに基づいてチャンネルをエンコード/パンするとき、外部コントローラを透過的に使

用してAmbisonicをパンできます。まったく同じコントロールが使用されます。 ただし、

Ambisonic RotationsはRotationsコントロールを使用するため、外部コントローラに個別にマッ

ピングする必要があります。 

既知の制限： 

● ダイバージェンス コントロールはAmbisonic エンコード/パンニング には影響を与えません。 

● Pyramix MixerはAmbisonic input StripのリモートMicPreのマルチチャンネル コネクションを行

うことができません。Horus, HapiのWebアクセスのPreAmpsページを使用してください。   
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Pyramix V12での変更 
General Master: 
Generate CD Image / SACD Edit Master は、Genrate Master に置き換わりました。 

Master Settings Section: 

Type  Sampling Rate  Resolution  Mode 

Red Book CD Image (PMI)  44.1kHz  16 bit  Mixdown 

DSD Edit Master (DSDIFF)  DSD64(SACD) - DSD128 - DSD256  1 bit  Midfown - DSD 
Renderging (DXD project) 

PCM Digital Release (MTFF)  44.1 - 48 - 88.2 - 96 - 176.4 - 192 - 
352.8(DXD) - 384 kHz 

24 bit - 32 
bit  Mixdown 

DSD Digital Release (MTFF)  DSD64(SACD) - DSD128 - DSD256  1 bit  Midfown - DSD 
Renderging (DXD project) 

新機能： 
操作ミスを抑制するために、Generate Master Settings での初期化が変更されました。 
Generate Masterダイアログの最終的なパラメータは以降同様にされますが、Master Type / Settingsはデ

フォルトのプロジェクトが持つ値に初期化されます。 
例： 

● Project が 44.1kHz = Red book CD Image (441k 16bit) 
● Project がPCM 48k/176.4k/192k/352.8k/384k =ProjectのサンプリングレートのMTFF PCM 

Digital Release 24bit  
● DXD Project = MTFF PCM Digital Release 32bit float 352.8k 
● DSD64/128/256 Project = MTFF DSD Digital Release, Project のサンプリング レートの DSD 

Renderging  
Digital Release はDSD128, DSD256 Edit Master をDSD rendering または Mixdown モードから作成できま

す。また、Album Publishing ではDSD128，DSD256インプット フォーマットが使用できます。 
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DSD Render mode では、まずレンダーするチャンネル順を指定する必要があります。 

 

MTFF DSD Digital Release Generation はPyramix v12 で新しく追加されたもので、Album Publishingま
たはDiscWriteにインポートできます。 

MTFF は、Generate Master で MTFF loss-less compression オプションが使用できます。 

 
注意：MTFF loss-less compression は、リニアPCMにのみ使用でき、Floating point PCMには使用できま

せん。 

Mixdown Processing section: 
● どのMaster Typeを作成するかにより、RenderもしくはNon-Realtime Mixdown が行えます。 
● DSD Edit MasterはDSD Sigma Delta Modulator Settings （Mixdown Modeの場合）に含まれまし

た。 
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Post Processing / Album Publishing: 

Album Publishing DSD Edit Masters のオプションに新しいDSTエンコーディングが加わ

りました。 
● Album Publishing でDSD Edit Master を作成する場合、工程でDSTエンコードを行うかを決める

チェックボックスができました。 
● Windowsのエクスプローラーで、DSD/DST DSDIFFファイルを右クリック > Properties を開くと

DSD/DST info タブが表示できます。 
● WindowsのエクスプローラーではDSTとDSDメディアは異なるアイコンとなります。 

 

DSD128, DSD256 Edit Master Generation 
● DSDx Digital Release Master を使用して Album Publishing を行うと、PCM処理無しでDSD128, 

DSD256 Edit Master を作成することができ、DSDxメディア トラックを作成することができま

す（DSD256 Master でDSD256 メディア トラックを作成するなど）。 

DSD Rendergin (Project DSD Render とGenerate Master): 
● （DSDをオリジナル サンプル レートで処理する）新機能により、DSD Rendering プロセッシン

グ（ゲインとクロスフェード）がオリジナルのDSD素材のサンプリング レートで行われます（

DSD64では64Fs，DSD128では128Fs, DSD256では256Fs）。 
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Album Publishing に Meco Sigma Delta Modulator を新たに搭載： 
● 新しいMeco SDM（output format の SDMセクションで利用可能）は、DSDフォーマットから別

のフォーマット（DSD256からDSD128など）への変換時に、高いサンプルレート（64および

128Fs）の中間マルチビット ステージを可能にします。 

 
注意：Pre-Sigma Delta Gain と Post SRC Gain がDSDフォーマットでサポートされました。 

Import MTFF Digital Release 
Pyramix V12では、MTFF Digital Release をタイムライン上にインポートでき、CDタグを編集できるよう

になりました。ワークフローはPMI CD Image / SACD Edited Master / SACD Cutting Master インポートと

似ています。アートワークのウインドゥはサイズ変更ができます。 Project > Import > MTFF Digital 
Release を選択してください。 
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DiscWrite: 
● MTFFのメタデータを編集できるようになりました。変更するとソース ファイルに保存または

書き換えるかと質問されます。 
● DSD MTFF Digital Release がDiscWriteでサポートされました（DSDIFF Edited Masterを作成で

きます）。 
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オーサリング テキストのバリデーションとレポート ジェネレーター 
カスタマーへの納品や工場納品にあたり、テキスト検証用のText Validator が使用できるようになりまし

た。 
● このValidatorはCDとSACD XTOCフォーマットをサポートしています。ファイナル マスターの

仕様に合ったキャラクターセットとキャラクターがチェックできます。 
○ Text Validator がPyramixで使用できます。 
○ Text Validator はView > Display Toc から選択すると実行されます。 
○ エラーが見つかった場合、エラーが起こった場所がError 行レポートに示されます。 

エラーが起こった場所のレポートの例 

 

● DiscWriteでのText Validator 
○ DiscWrite でImageやDigital Release を開くと、Text Validator が起動します。 
○ エラーが見つかった場合、エラーレポート ファイル（.txt）で見ることができます。 
○ エラー レポートには、無効なキャラクタ セットとエラーの位置が記されています。 
○ 報告されたエラーは、DiscWrite の Edit view で修正できます。 

 

​dsp ​ Japan​  ​Ltd,​ ​4-8-5 Nakameguro, Meguro-ku, Tokyo 153-0061 

T : 03-5723-8181 F : 03-3794-5283 U : http://www.dspj.co.jp 
20 



 

 

 

新しいCD text import（CDTEXT.BIN） 
CD textはDDPフォルダに別ファイルとして存在します。通常、CDTEXT.BINと名前がついており、CDに
書かれる raw CD-Textです。これをPyramixの CD Text Tab (CDTEXT.BIN）にインポートできます。ま

た、ロードしたCDのCDテキストを取得できます。 
● CDテキストのみが再インポートされ（マーカーもタイムスタンプもなし）、既存のCDトラック

を現在のCDに塗りつぶし、新しいトラックを作成しません。 
● 現在のCDにトラックが存在しない場合は、CDテキストに関するディスク情報のみがインポート

されます。 
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新しい SACD Cutting Master generation 機能 
v11.1でのSACD CM wizard を置き換える機能です。 

Projectに有効なSACD discがある場合、Pyramixの Projectメニューに新しいダイアログが利用できま

す。 

明確なシングル ダイアログ ユーザーインターフェイスを使用して、SACD cutting master ジェネレー

ション用の SACD Disc Builder スクリプトの生成を行うことに焦点を当てています。 

各discで、下記の入力を行う必要があります。 
● 1つまたは２つのDSD64 Edited master（DSTエンコーディングは必要な場合オンザフライで行

われます） 
● discの名前 
● SACD Cutting masterの出力用に、２つのターゲット フォルダー 

提供されたデータ（ソースデータファイル、TOC、テキスト メタデータ）の検証が各状態で実行され、

ユーザーに通知されます。 

スクリプトが生成されると、ユーザーは外部SACD Disc Builderアプリケーションで実際のCutting 
Masterのジェネレーションに自動的に進むことが選択できます。 
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Mixerの改良： 
● VCAストリップはInputストリップエリアのどこにでも配置できます。 
● Aux GroupストリップはInputストリップエリアのどこにでも配置できます。 
● General Mixing Bus セクションはMatrix Gridとして動作します。 

○ SendコンポーネンツのOn/Offボタンをクリックしてマウスをドラッグしつづけるとダ

イアログパッチングが作成されます。 
○ CONTROLキーを押すとCONTROLキーを押すと、対角線ではなく長方形のオン/オフブ

ロックが作成されます。 リージョンの迅速なパッチ適用解除に役立ちます。 
○ この機能は、ストリップとバスの両方でミキサー全体が折りたたまれている場合に最適

に使用されますが、一部のストリップまたはバスが折り畳まれていない場合でも機能し

ます。 
● RouteページのSave/Load 

○ ミキサーのRoutingページにLoadとSaveのボタンが付きました。 
○ コンソール入力, 出力, ダイレクトアウトのルーティングはXMLファイルとしてロード, 

セーブができます。 

新しいMixerのスクロール機能 
● Pyramix/Ovationのミキサーは、マウス のホイールをサポートしました。 

○ そのままで、バスをスクロールできます。 
○ CONTROLを押しながらInputエリアにポインターを置きホイールを回すと、Inputをスク

ロールします。また、Masterエリアにポインターがあると、Masterストリップをスク

ロールします。 
● MasterとBussはInputストリップと同様にスクロールできるようになりました。 

○ Mixerの左端を掴んでInputストリップの表示エリアを変更できます。 
○ Mixerの左端を掴んでMasterストリップの表示エリアを変更できます。 
○ Mixerの上端と下端を掴んでMx, Aux, Groupの表示エリアを変更できます。 

● 右下にコンテキスチャル メニューがあり、＋ボタンで新しいエントリーが使用できます： 
○ Console > Reveal All: Mixerを最大に表示し、全てのInput, Master, Buss を表示させま

す。 
○ Input Strips > Scroll Half: 現在表示されているInputストリップの表示領域を半分にしま

す。 
○ Input Strips > Reveal All: 全てのInputストリップを表示します。 
○ Masters > Scroll Half: 現在表示されているMasterストリップの表示領域を半分にしま

す。 
○ Masters > Reveal All: 全てのInputストリップを表示します。 
○ Busses > Scroll Half: 現在表示されているBussesストリップの表示領域を半分にしま

す。 
○ Busses > Reveal All: 全てのBussesストリップを表示します。 

● このメニューは次の順に表示されます： 
○ Console  
○ Input Strips 
○ Masters 
○ Busses 

● 次のメニューが加えられました： 
○ Faders/Effects/Pan 

■ Show All 
■ Hide All 
■ Collapse All 
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これにより、Fader, Mute, PreAmp, Effect, Pan などの表示/非表示による目視が素早く行えま

す。 

● Mixer VSTプラグインSplit by Columnsレイアウトオプション。フラッピングダイアログではな

く、すべてのプラグインを一度に表示します。 

 
非常に大きなプラグインスイートをインストールした場合、すべてのプラグインが列に表示さ

れるとは限りません。 

● Mixer: あたらしい Speaker Set 定義が加わりました。 
○ 9.1 
○ 7.1.6 
○ 9.1.2 
○ 9.1.4 
○ 9.1.6 

その他の改良 
● メニューとツールバーのボタンに”Clips > Disable Group”が加わりました。これは一時的に

GroupされたクリップのGroupを解除する機能です。 
● クリップのEnvelopeが.5dBになりました。 
● Shiftキーを使用してクリップ全体を選択すると、以前のようにクリップの外側だけでなく、ク

リップ内をクリックできるようになりました。 
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Pyramix V12の既知の問題 

● 最新のv12キーが必要です。 

● インストール情報については​Pyramix V12インストールガイドを​参照してください。 

● カスタムインストールはお勧めできません。特定のシナリオでは、一部のコンポーネントが正

しくインストールされません（登録DLLエラー）。 

● Pyramix v12.0プロジェクトはPyramix v11.1と下位互換性がありません。そのようなプロジェク

トをPyramix v11.1で開くには、「Save Special as v11.1」を実行する必要があります。 
注意：Ambisonic v12プロジェクトはPyramix v11.1と完全な互換性はありません 

● Ambisonicのサポート：Ambisonic Busのチャンネルタイプは変更できません。 

● Ambisonicのサポート：Panner Divergenceコントロールは、Ambisonic Encoding / Panningに
は今のところ影響しません。 

● Ambisonicのサポート：Pyramix Mixerは現在、リモートMicPre用のAmbisonic入力ストリップ

用のマルチチャンネル接続を許可していません。 
HorusとHapiのWeb Access PreAmpsページを使用してください。 

● プロジェクト作成時のデフォルトのレコード・フォーマットは、リカバリーおよびコンプライ

アンスのためにPMFからBWFに変更されました。PMFを使用したいユーザーは変更可能です。 

● NVidiaグラフィックカードを使用しているWavesプラグインユーザーは、Threaded 
Optimizationがオフになっていることを確認する必要があります。オンに設定すると、Waves 
VSTプラグインで問題が発生する可能性があります。 
こちらのリンクを参照して​ください。https​ : 
//confluence.merging.com/display/PUBLICDOC/Graphic+cards+recommended+settings 

● バックグラウンド録音を行うときにフォルダが選択されていない場合、バックグラウンドレ

コーダは最後にマウントされたフォルダに録音します。 

● PMX111-19：99以上のインデックスを持つCDイメージ ''デジタルリリース ''アルバム出版 'の生

成はサポートされていません（Redbook制限） 

● PMX111-71：Mixer：Delay CompensationがOFFの場合、Mixerを再構築するとメータリングが

失われます。 
回避策：Delay CompensationをONにするか、2回目のMixer Rebuildを実行してください。 

● PMX111-222：安定性の理由からMedia Managerの詳細ビューを使用することをお勧めしま

す。 

● PMX111-147：IzotopeのRX6 De-Clickのようなプラグインを使ってFXRenderingをすると、プレ

ビューでPyramixがフリーズ/クラッシュすることがある（iZotopeに報告） 

● PMX111-184：ミキサー：ミキサーでバスツールとストリップツールを追加または移動したと

きに整合性が取れない、ミキサーを再構築する、またはスクロールしてUIを更新する 
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● PMX111-22：2つの重なっているクリップが同じメディアをプロジェクトとは異なるサンプリ

ングレートで参照していると、重なっている部分でノイズが発生します。 
このようなワークフローを使用する前に、これらのメディアをプロジェクトのサンプリング

レートに変換してください。 

● GAIA-1020：44.1kHz以外のサンプリングレートでのプロジェクトでアクティブなメトロノーム

とのミックスダウンがクラッシュを引き起こす可能性がある 

● ファイナルチェックメータリング：DXDではサポートされず、6チャンネルに制限されていま

す。 

● 固定カーソルモードは、リアルタイム再生編集には推奨しません。 

● Black magic Design ASIOドライバがASIO4ALLと競合し、VS3コントロールパネルがクラッシュ

する可能性があります。  

● Windows 7 MassCoreユーザーは、システムを正しく構成しているにもかかわらず、構成に関す

る警告メッセージが表示されることがありました。 
そのような場合は、​このページの最後にある手順に従ってください​。   

● v12.xのライブラリ形式は、v7.1としての古いPyramixリリースと互換性がありません。   
v7.1として保存はライブラリメニューで利用可能です。 

● Pyramixには "Not Enough Streams available"という警告メッセージがあります。 
これは、利用可能な最大レコード入力に達すると発生します。そのような場合は、入力数を減

らすか、入力を消費しているバックグラウンドレコーダーを無効にすることをお勧めします。 
その後、再生を開始するたびに「プロジェクトの再有効化」というメッセージボックスが表示

される場合は、回避するためにプロジェクトを閉じてから再度開きます。  
セカンダリデバイス/ ASIOブリッジまたはRewireを有効にしている場合はVS3コントロールパネ

ルの下でStreamsを消費します。使用していない場合はこのオプションを無効にします。 

● PyramixマルチチャンネルMCSストリップはプリアンプをサポートしませんが、VCAストリップ

はサポートします。 
正しく通信するために、必ず最新のHorus / Hapiファームウェアをインストールしてください。 

● ミキサーオートメーションバスAUXセンド。   
ユーザーがAux Sendバスのオン/オフを自動化するのではなく、単にAuxのゲインを自動化する

ことをお勧めします。これが遅延補償問題を引き起こす可能性があるので。 

● 新しいバスレイアウト/構造を含むV12プロジェクトは、Save Special v9.0プロジェクト内に保

存できません。 
新しいBusesレイアウト/構造を含むPyramix v12プロジェクトは、Save Special v9.0プロジェク

ト内に保存することができません。警告メッセージが表示されてしまうためです。 

● 特定のプラグインの ​サードパーティソフトウェアに​問題がある場合は、VSTプラグインのサ

ポートについてサードパーティソフトウェアのページを参照してください。 

● Mono Legacy Bus conversion 
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レガシーバスの変換。 新しいバスのアーキテクチャにより、ミックスバスにはゲイン制御がな

いため、モノミックスバスはモノAuxバスに変換され、モノミックスバスには変換されなくな

りました。 

● Pyramix Video 
ビデオWrapダイアログが非表示になる場合があります。ユーザーはAltキーを使用して、一番上

に表示する必要があります。 
PyramixビデオのConsolidateはサポートされていません。 
ナッジ（<>）オプションを使用すると、Pyramixビデオが追従しない場合があります。 
Blackmagic Designカードでは、逆方向の再生によりオフセットが発生する場合があります。 
Blackmagic Designのカードでは、最初に停止せずにチェイスすると遅延が正しくない場合があ

ります。 

● PMF in Mixdown 
PMFファイル形式は、コンプライアンスの問題によりPyramix v11.1のMixdown形式から削除さ

れました。 Pyramix v11.1での推奨事項は次のとおりです。 
● 録音の場合：Pyramix v11.1では、コンプライアンス上の理由からデフォルトの記録形

式はBWFです。 
● Mixdownの場合：MTFFを推奨します。 
● Album Publishingの場合：信号の流れを改善するためにDigital Release で選択した形式 
● Renderの場合：元の形式またはPMFまたはMTFFでレンダリングすることをお勧めしま

す。 DSDIFFは推奨されません。 
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